Introduction

This demonstration guide follows the list from page 2, which shows the demonstrations included in this document. Each demonstration is given a brief description of its function and the corresponding measurement steps on the signal generator and/or signal analyzer.
CMMB Measurement Details

Measurement Details

All of the RF transmitter measurements as defined by the CMMB standard, as well as a wide range of additional measurements and analysis tools, are available with a press of a button (Table 2). These measurements are fully remote controllable via the IEC/IEEE bus or LAN, using SCPI commands.

Analog baseband measurements are available on the Keysight Technologies, Inc. MXA signal analyzer equipped with BBIQ hardware. Supported baseband measurements include all of the modulation quality plus I/Q waveform and CCDF measurements.

<table>
<thead>
<tr>
<th>Technology</th>
<th>DTMB (CTTB)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Measurement application</td>
<td>N6156A, W6156A</td>
</tr>
<tr>
<td>X-Series signal analyzer</td>
<td>PXA, MXA, EXA, CXA</td>
</tr>
<tr>
<td>Measurements</td>
<td>Channel power</td>
</tr>
<tr>
<td></td>
<td>RF spectrum</td>
</tr>
<tr>
<td></td>
<td>Shoulder attenuation</td>
</tr>
<tr>
<td></td>
<td>Spectrum mask (with analog TV in adjacent channel)</td>
</tr>
<tr>
<td></td>
<td>Adjacent channel power</td>
</tr>
<tr>
<td></td>
<td>Spectrum emission mask</td>
</tr>
<tr>
<td></td>
<td>Monitor spectrum</td>
</tr>
<tr>
<td></td>
<td>IQ waveform</td>
</tr>
<tr>
<td>Modulation accuracy</td>
<td>RMS EVM (%)</td>
</tr>
<tr>
<td></td>
<td>Peak EVM (%)</td>
</tr>
<tr>
<td></td>
<td>Position of peak EVM</td>
</tr>
<tr>
<td></td>
<td>RMS MER (dB)</td>
</tr>
<tr>
<td></td>
<td>Peak MER (dB)</td>
</tr>
<tr>
<td></td>
<td>Position of peak MER</td>
</tr>
<tr>
<td></td>
<td>RMS mag error (%)</td>
</tr>
<tr>
<td></td>
<td>Peak mag error (%)</td>
</tr>
<tr>
<td></td>
<td>Position of peak mag error</td>
</tr>
<tr>
<td></td>
<td>RMS phase error (deg)</td>
</tr>
<tr>
<td></td>
<td>Peak phase error (deg)</td>
</tr>
<tr>
<td></td>
<td>Position of peak phase error</td>
</tr>
<tr>
<td></td>
<td>Frequency error (Hz)</td>
</tr>
<tr>
<td></td>
<td>Clock error (Hz)</td>
</tr>
<tr>
<td></td>
<td>Tx power (dBm)</td>
</tr>
<tr>
<td></td>
<td>Quadrature error (deg)</td>
</tr>
<tr>
<td></td>
<td>Amplitude imbalance (%)</td>
</tr>
<tr>
<td></td>
<td>MER/EVM vs. subcarriers/frequency</td>
</tr>
<tr>
<td></td>
<td>Ampt vs subcarriers (dB)</td>
</tr>
<tr>
<td></td>
<td>Phase vs subcarriers (deg)</td>
</tr>
<tr>
<td></td>
<td>Group Delay vs subcarriers (ns)</td>
</tr>
<tr>
<td></td>
<td>Channel impulse response (dB)</td>
</tr>
<tr>
<td></td>
<td>MER of data block (dB)</td>
</tr>
<tr>
<td></td>
<td>MER of system info (dB)</td>
</tr>
<tr>
<td></td>
<td>MER of header (dB)</td>
</tr>
<tr>
<td></td>
<td>In-band spectrum ripple Amax-Ac (dB)</td>
</tr>
<tr>
<td></td>
<td>In-band spectrum ripple Amin-Ac (dB)</td>
</tr>
</tbody>
</table>
Demonstration Preparation

Minimum equipment configuration requirements

All demonstrations use an X-Series signal analyzer and the MXG vector signal generator. Keystrokes surrounded by [ ] indicate front-panel keys; keystrokes surrounded by { } indicate softkeys located on the display.

<table>
<thead>
<tr>
<th>Product type</th>
<th>Model number</th>
<th>Required options</th>
</tr>
</thead>
<tbody>
<tr>
<td>MXG vector signal generator</td>
<td>N5182A (Firmware revision A.01.20 or later)</td>
<td>– 651, 652, or 654: internal baseband generator (30 M/60 M/125 Msa/s, 8 Msa) – 019: Upgrade baseband generator memory to 64 Msa (recommended)</td>
</tr>
<tr>
<td>Signal Studio for digital video</td>
<td>N7623B (Software version 1.6.4.0 or later)</td>
<td>Please check N7623B Signal Studio Web page for the latest version <a href="http://www.keysight.com/find/SignalStudio">www.keysight.com/find/SignalStudio</a></td>
</tr>
<tr>
<td>X-Series signal analyzer</td>
<td>N9000A, N9010A, N9020A, or N9030A¹</td>
<td>Recommended: – EA3: Electric attenuator, 3.6 GHz – P0X: Preamplifier – P0x (P03, P08 (P07 for CXA)) – B25, B40 or B1X: Analysis bandwidth up to 25 MHz, 40 MHz or 140 MHz – BBA: Analog baseband IQ inputs (for analog baseband IQ analysis) for N9020A MXA Required: – 503, 508, 507, (EXA and CXA), 513 or 526, 513 and 526 not available on CXA</td>
</tr>
<tr>
<td>CMMB measurement application</td>
<td>N6156A – N9010A, N9020A, N9030A¹ W6156A – N9000A only</td>
<td>Required: – 2FP: CMMB measurement application, fixed perpetual license OR – 2TP: CMMB measurement application, transportable license (For PXA/MXA/CXA)</td>
</tr>
<tr>
<td>Controller PC for Digital Video</td>
<td></td>
<td>Install N7623B to generate and download the signal waveform into the MXG via GPIB or LAN (TCP/IP). Please refer to the online documentation for installation and setup</td>
</tr>
<tr>
<td>Signal Studio¹</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

¹ Keysight X-Series PXA/MXA/EXA/CXA signal analyzers can be used as the controller PC to install the N7623B Signal Studio software and download waveforms into the MXG via LAN or GPIB.

Helpful tip:

Update your instrument firmware and software to the latest version, at

www.keysight.com/find/mxa_software
www.keysight.com/find/signalstudio
Demonstration Setup

Connect the PC, X-Series, and MXG

Connect a PC (loaded with Keysight N7623B Signal Studio for Digital Video software and Keysight I/O libraries) to the N5182A MXG via GPIB or LAN. Follow the Signal Studio instruction to complete the connection, and then perform the following steps to interconnect the X-Series signal analyzer and MXG (see Figure 1 for a graphical overview):

A. Connect the MXG RF output port to the X-Series signal analyzer RF input port
B. Connect the MXG 10 MHz out to the X-Series signal analyzer Ext Ref in port (rear panel)
Demonstrations

Demonstration 1:
Set up Signal Studio for Digital Video setup on an N5182A MXG

The Keysight N7623B Signal Studio for Digital Video is a Windows-based utility that simplifies the creation of standards-based or customized digital video signals. The waveform is downloaded into the MXG vector signal generator, which generates RF or IQ signals.

<table>
<thead>
<tr>
<th>Instructions</th>
<th>Keystrokes</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>On the MXG:</strong></td>
<td></td>
</tr>
<tr>
<td>Preset the MXG</td>
<td>[Preset]</td>
</tr>
<tr>
<td>Check the IP address</td>
<td>[Utility] (I/O Config) (LAN Setup)</td>
</tr>
<tr>
<td><strong>On the Signal Studio software:</strong></td>
<td></td>
</tr>
<tr>
<td>Run the Keysight Signal Studio for digital video</td>
<td>Double-click on the Digital Video shortcut on the desktop or access the program via the Windows start menu</td>
</tr>
<tr>
<td>Verify the software is communicating with the instrument via the GPIB or LAN (TCP/IP) link</td>
<td>To establish a new connection, click on the (System) pull-down menu at the top of the Signal Studio program window. Next, select (Run System Configuration Wizard)</td>
</tr>
<tr>
<td>Select the CMMB format</td>
<td>Click on the (Format) pull-down menu at the top of the Signal Studio program window. Next, select (CMMB)</td>
</tr>
<tr>
<td>Set the parameters of the signal generator with center frequency 634 MHz, amplitude –20 dBm, RF output turned on, and ALC On</td>
<td>Click Signal Generator at the left on the Explorer menu. Instrument model number: N5162A/N5182A Press [Preset] green button at the top. Frequency = 634 MHz, Amplitude = –20 dBm, RF Output = On, ALC = On</td>
</tr>
<tr>
<td>Confirm the waveform setup from upper level</td>
<td>Click Waveform Setup to see the fundamental waveform signal setups, use the default settings</td>
</tr>
<tr>
<td>Set a test signal for demonstrations</td>
<td>Click Carrier0 under Waveform Setup on the left of the explorer menu to see the setups on Carrier0; use the default settings. Click PLCH under Carrier0 to set the parameters of each PLCH – Click + (add a new channel) to add a PLCH – Set the parameters for the PLCH in the right bottom window</td>
</tr>
<tr>
<td>Download the signal to the MXG</td>
<td>Click (generate and download button) on the top tool bar. If you encounter any errors, please refer to the online help in the Signal Studio software</td>
</tr>
<tr>
<td>Save the signal file for future use</td>
<td>File &gt; Save Setting File &gt; CMMB.scp (create filename)</td>
</tr>
<tr>
<td>Export the waveform file for future use</td>
<td>File &gt; Export Waveform Data &gt; CMMB.wfm (create filename)</td>
</tr>
</tbody>
</table>
Demonstration 2:

Channel power

The channel power measurement has two views: RF Spectrum and shoulder attenuation.

- The RF spectrum view measures and reports the integrated power in a CMMB defined bandwidth and power spectral density (PSD) displayed in dBm/Hz or dBm/MHz.

- The shoulder attenuation view measures the power difference between the center frequency (CF) and the shoulder point (4.2 MHz from CF).

Instructions

Keystrokes

<table>
<thead>
<tr>
<th>On the X-Series in CMMB mode:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Preset the MXA</td>
</tr>
<tr>
<td>Select CMMB mode</td>
</tr>
<tr>
<td>Choose the device under test</td>
</tr>
<tr>
<td>Set a center frequency at 634 MHz</td>
</tr>
<tr>
<td>Select channel power measurement (RF spectrum default)</td>
</tr>
<tr>
<td>Switch to shoulder attenuation view</td>
</tr>
</tbody>
</table>

Figure 3. Channel power measurement with RF spectrum view

Figure 4. Channel power measurement with shoulder attenuation view
Demonstration 3:

Adjacent channel power (ACP)

ACP is a measurement of the power in adjacent in-band or out-band channels relative to the transmitted power. The ACP test verifies the ability of the modulator or transmitter to limit the interference produced by the transmitted signal to other receivers operating at the adjacent in-band or adjacent out-band RF channel.

The ACP measurement results should be similar to Figure 5. The text window shows the power inside and outside the adjacent channels as the standard requires.

<table>
<thead>
<tr>
<th>Instructions</th>
<th>Keystrokes</th>
</tr>
</thead>
<tbody>
<tr>
<td>On the X-Series in CMMB mode:</td>
<td></td>
</tr>
<tr>
<td>Activate adjacent channel power (ACP) measurement</td>
<td>[Meas] {ACP}</td>
</tr>
<tr>
<td>Compare the measurement result with noise correction turned on (default is off). A better ACP result is achieved with noise correction on (Figure 5)</td>
<td>[Meas Setup] (More 1 of 2) {Noise Correction On}</td>
</tr>
</tbody>
</table>

Figure 5. ACP measurement with noise correction on
Demonstration 4: Power stat CCDF

The power stat complementary cumulative distortion function (CCDF) is a statistical method used to interpret the peak-to-average ratio of digitally modulated noise-like signals. It is a key tool for the power amplifier design in CMMB transmitters, which is particularly challenging because the amplifier must be capable of handling the high peak-to-average ratio while maintaining good adjacent channel leakage performance.

Instructions Keystrokes

- **On the X-Series in CMMB mode:**
  
  - Activate the power stat CCDF measurement: [Meas] [Power Stat CCDF]
  
  - Store a reference trace: [Trace/Detector] (Store Ref Trace)
  
  - Turn on reference trace: [Trace/Detector] (Ref Trace On)

---

![Figure 6. Power stat CCDF measurement](image)

![Figure 7. Power stat CCDF measurement with reference trace](image)
Demonstration 5:

Spectrum emission mask

The spectrum emission mask (SEM) measurement can compare the total power level within the defined carrier bandwidth and the given offset channel on both sides of the carrier frequency to levels allowed by the CMMB standard. This measurement rebounds to the design of the power amplifier in the CMMB transmitter, and it is a key measurement linking amplifier linearity and other performance characteristics to the stringent system specifications.

In an SEM measurement, you may need to use the amplitude correction function. For more details, refer to Appendix A.

<table>
<thead>
<tr>
<th>Instructions</th>
<th>Keystrokes</th>
</tr>
</thead>
<tbody>
<tr>
<td>On the X-Series in CMMB mode:</td>
<td></td>
</tr>
<tr>
<td>Activate spectrum emission mask</td>
<td>[Meas] {Spectrum Emissions}</td>
</tr>
<tr>
<td>Input the value of the attenuator (for real CMMB transmitter)</td>
<td>[Input/Output] {External Gain} {Ext Preamp}</td>
</tr>
<tr>
<td>Recall or edit the correction table</td>
<td>[Input/Output] {More 1 of 2} {Corrections} {Edit} or [Recall] {Data}</td>
</tr>
<tr>
<td>Turn correction on</td>
<td>[Input/Output] {More 1 of 2} {Corrections} {On}</td>
</tr>
</tbody>
</table>

Figure 8. Spectrum emission mask measurement after amplitude correction

Helpful tip:

For the format of the file to be recalled, first edit several points using the onscreen editor, then press Save, Data (Export) Correction 1, Save As... to save the correction data to a file. Open the file and view the format.
Demonstration 6: Modulation accuracy

The modulation accuracy measurement is necessary to perform CMMB-defined tests and to ensure proper operations of exciters or transmitters. It supports measurements on the specified PLCH, timeslots, or frame and demodulates the signal automatically using the control information from the CLCH. In the mod accuracy measurement, you can measure the EVM, MER, magnitude error, phase error, freq error, quadrature error, and amplitude imbalance. Error vector magnitude (EVM) and modulation error ratio (MER) are defined in the CMMB standard to represent the total signal degradation including noise, interferences, or distortions, at the input of a commercial receiver’s decision circuits, which gives an indication of the ability of that receiver to correctly decode the signal.

Available views and traces in modulation accuracy:
- **1/Q measured polar graph view** (Figure 9): This is a two-window view that displays
  - Results metrics (left)
  - 1/Q measured polar graph (right)
- **1/Q error view (quad view)** (Figure 10): This is a four-window view which includes:
  - MER/EVM vs. sub-carrier/frequency view
  - Logical channel (top right)
  - Polar graph (bottom left)
  - Results metrics (bottom right)
- **Channel frequency response view** (Figure 11): This is a three-window view which includes:
  - Amplitude vs. sub-carrier (top)
  - Phase vs. sub-carrier (middle)
  - Group delay vs. sub-carrier (bottom)
- **Channel impulse response view** (Figure 12): This two-window view displays the state of the channel in time domain which the signal has gone through.
  - Peak table (left)
  - Amplitude vs. time (right)
- **Spectrum flatness view** (Figure 13): This two-window view can be used to verify whether the spectrum flatness meets the transmitter or exciter device standard with a PASS/FAIL indicator and shows
  - Amplitude vs. sub-carrier (top)
  - Results metrics (bottom)
- **MER vs. timeslot view** (Figure 14): This view lists the MER results on each timeslot
- **Result metrics view** (Figure 14): This view displays the summary of all the detailed numeric result metrics
### Instructions

**On the MXA/EXA in CMMB mode:**

#### Set triggers (e.g., internal trigger)

- Set the internal triggers: 
  
  ```
  [Trigger] (More 1 of 2) (Periodic Timer)
  ```

- Synchronize the trigger with the beginning of a CMMB frame:
  
  ```
  [Meas Setup] (Advanced) (Sync Frame Now)
  ```

#### Set up measurement

- Set the measurement type:
  
  ```
  [Meas Setup] (Meas type) (PLCH)
  ```

- Choose the PLCH to measure:
  
  ```
  [Meas] (PLCH Settings) (PLCH Type) (Toggle to SLCH), (SLCH Index) (0)
  ```

- Activate the modulation accuracy measurement (I/Q measured polar graph default, Figure 9):
  
  ```
  [Meas Setup] (Mod Accuracy)
  ```

- Switch to the IQ error view (Figure 10):
  
  ```
  [View/Display] (I/Q Error (Quad View))
  ```

- View the channel frequency response (Figure 11):
  
  ```
  [View/Display] (Channel Frequency Response)
  ```

- View the channel impulse response (Figure 12):
  
  ```
  [View/Display] (Channel Impulse Response)
  ```

- View the spectrum flatness (Figure 13):
  
  ```
  [View/Display] (Spectrum Flatness)
  ```

- View the MER vs. timeslot results (Figure 14):
  
  ```
  [View/Display] (More 1 of 2) (MER vs. Timeslot)
  ```

- View the result metrics (Figure 15):
  
  ```
  [View/Display] (Result Metrics)
  ```

---

**Helpful tip:**

To make the mod accuracy measurement of CMMB signals, you need to set up triggers. Three types of triggers are available: external trigger, periodic trigger, and free run. For more detail, refer to the modulation analysis settings table in Appendix B.

---

**Helpful tip:**

If the measurement type is timeslot, you need to set the modulation format manually under the timeslot settings menu and make sure that the timeslots to be measured use the same modulation format.
Figure 9. Modulation accuracy measurement with I/Q measured polar graph view

Figure 10. Modulation accuracy measurements with I/Q error view (quad view)

Figure 11. Modulation accuracy measurement with channel frequency response view

Figure 12. Modulation accuracy measurement with channel impulse response view
Figure 13. Modulation accuracy measurement with spectrum flatness view

Figure 14. Modulation accuracy measurement with result metrics view

Figure 15. Modulation accuracy measurement with MER vs. timeslot view

Figure 16. Channel impulse response view with two-paths

Helpful tip:

The MER vs. Timeslot (Figure 14) only shows MER results for timeslot 1-3. To see the MER on the whole frame, press **Meas Setup, Meas Type, Frame**. You may need to wait for a while as the calculation of results on a whole frame takes more time.

Helpful tip:

The peak table window in Channel Impulse Response view is very helpful in identifying the multi-paths existing in the channel. Figure 16 is an example of a four-path channel with 0, 10, 20, and 30 µs delay respectively.
Demonstration 7:

Occupied bandwidth

The Occupied BW measurement measures the bandwidth containing 99% of the total power on CMMB signals.

Instructions Keystrokes
---
On the X-Series in CMMB mode:
Measure the occupied bandwidth (Figure 17) [Meas] (Occupied BW)
Adjust the parameters [Meas Setup]

Figure 17. Occupied bandwidth measurement

Demonstration 8:

Monitor spectrum

Monitor spectrum measurement is used as a quick, convenient means of looking at the entire spectrum. While it is similar to the spectrum analyzer mode, the functionality is greatly reduced for easy operation. The main purpose of the measurement is to show the spectrum.

Instructions Keystrokes
---
On the X-Series in CMMB mode:
Activate monitor spectrum measurement [Meas] (Monitor Spectrum)

Figure 18. Monitor spectrum measurement
Demonstration 9: IQ waveform

IQ waveform measurement is a generic measurement for viewing the input signal waveforms in the time domain. Under this measurement, there is also an I/Q waveform window, which shows the I and Q signal waveforms in parameters of voltage versus time to disclose the voltages that comprise the complex modulated waveform of a digital signal. The waveform measurement can be used to perform general-purpose power measurements to a high degree of accuracy as well.

**Instructions**

**Keystrokes**

**On the X-Series in CMMB mode:**

Activate IQ waveform measurement (RF envelope default)  
[Meas] [IQ Waveform]

View the I/Q waveform  
[View/Display] [I/Q Waveform]

---

Figure 19. IQ waveform measurement with RF envelope view

Figure 20. IQ waveform measurement with I/Q waveform view
Appendix A:

Using amplitude correction in the SEM measurement

The dynamic range of the RF output of an actual CMMB transmitter typically exceeds the dynamic range of the analyzer. Therefore, the direct measurement result is always "FAIL" and cannot reflect the actual RF output.

To measure the spectrum mask of the transmitter’s RF output, there are two methods.

Method 1

Figure 20 shows a diagram of the spectrum mask measurement when the CMMB transmitter has an output filter.

The steps for measuring the spectrum mask are as follows:
1. Measure the frequency response of the output filter using a network analyzer or a combination of signal source and signal analyzer.
2. Measure the signal transmitted at point A as shown in Figure 21.
3. Apply amplitude correction on the spectrum value measured in (2) using the filter’s response from (1).

The correction data is typically a table of the negative values of the filter’s frequency response, in dB, at a number of frequency points across the band.

![Figure 21. Diagram for spectrum mask measurement on a CMMB transmitter with an output filter](image)

Method 2

If the transmitter does not have an output filter, an external filter with a band-block filter frequency response should be added after the transmitter for the measurement arrangement, as shown in Figure 22.

The steps for measuring the spectrum mask are as follows:
1. Measure the frequency response of the output filter using a network analyzer or a combination of signal source and signal analyzer.
2. Measure the signal transmitted at point B as shown in Figure 22.
3. Apply amplitude correction on the spectrum value measured in (2) using the filter’s response from (1).

The correction data is typically a table of the negative values of the filter’s frequency response, in dB, at a number of frequency points across the band.

![Figure 22. Diagram for spectrum mask measurement on a CMMB transmitter with an output filter](image)
Appendix B: Using triggers in the mod accuracy measurement

When making a CMMB mod accuracy measurement, you need to set up triggers. This section focuses on the reasons and methods for using and setting triggers in a CMMB mod accuracy measurement, and explains three different measurement types: timeslot, PLCH, and frame.

Reasons for using triggers
Due to the structure of PLCH, different kinds of modulation schemes may coexist in a CMMB signal. To demodulate the signal, you need to:

1. Capture the desired signal, e.g. timeslot 2 (TS2), or service logical channel 10 (SLCH10)
2. Identify the modulation format

Capturing the desired signal is the first step in the demodulation, and a trigger is needed to provide the reference point of the entire CMMB data flow, as shown in Figure 22. Adjusting the measurement offset makes it convenient to find and capture the desired signal.

Here the trigger can be a 1-PPS clock from a GPS or a periodic timer trigger with the period of 1 s, the length of one CMMB frame. The trigger is set to occur at the start time of TS0 so that the offset time can be adjusted to capture any signal in a frame.

The modulation format can be either automatically decoded from the CLCH that occupies TS0 or set manually. Depending upon the purpose of the test, three measurement types are available: PLCH, timeslot, and frame.

- The PLCH type measures a manually specified SLCH using the modulation formats decoded from the CLCH.
- The timeslot type measures a manually specified timeslot range using manually specified modulation formats.
- The frame type measures the entire frame using the modulation formats decoded from the CLCH.

Figure 23. Capture the desired signal (e.g. TS2, SLCH10) according to trigger position TS0
Methods of setting up triggers
To set up triggers, there are three methods:

Method 1
The periodic timer trigger generated inside the signal analyzer is used. This is the most convenient method. The measurement system is shown in Figure 24. Set up the trigger as follows:
1. Set the instrument to generate a periodic trigger inside. Press [Trigger], (More 1 of 2), (Periodic Timer).
2. Synchronize the generated trigger with the beginning of the CMMB frame. Press [Meas Setup], (Advanced), (Sync Frame Now).
3. Measure the desired timeslots, PLCH (including CLCH and SLCH), or the entire frame.

Method 2
If the transmitter/exciter under test has a 1-PPS clock for synchronization, the measurement system can be set up as shown in Figure 25.
The steps for setting up the measurement system are:
1. Connect the output signal of the CMMB transmitter/exciter to the RF input port of the analyzer using appropriate cables, attenuators, and adapters.
2. Connect the 1-PPS output of the GPS clock to both the TRIGGER 1 IN port on the rear of the spectrum analyzer and the 1-PPS input of the CMMB transmitter.
3. Optional: Connect the 10 MHz output of the GPS clock to the external Reference In port of the CMMB transmitter and signal analyzer respectively.
4. On the signal analyzer, press Trigger, External 1 to set external 1 as trigger.
5. Measure the specified timeslots, PLCH (including CLCH and SLCH), or the entire frame.

Method 3
If all of the timeslots in a CMMB frame use the same modulation format or run under the test mode, you can use the free run mode. The measurement system connection is the same as in Figure 25. Set up the trigger and measurement as follows:
1. Set the trigger to free run mode. Press [Trigger], (Free Run).
2. Set the modulation format in use (e.g., QPSK). Press [Meas Setup], (Timeslot Settings), (Modulation Format) (QPSK).
3. Randomly capture one timeslot and make measurements. The timeslot number will be displayed in meas bar. The FREERUN trigger only supports the timeslot meas type.
myKeysight
www.keysight.com/find/mykeysight
A personalized view into the information most relevant to you.

LAN eXtensions for Instruments puts the power of Ethernet and the
Web inside your test systems. Keysight is a founding member of the LXI
consortium.

www.keysight.com/find/ThreeYearWarranty
Keysight’s commitment to superior product quality and lower total cost
of ownership. The only test and measurement company with three-year
warranty standard on all instruments, worldwide.

Keysight Assurance Plans
www.keysight.com/find/AssurancePlans
Up to five years of protection and no budgetary surprises to ensure your
instruments are operating to specification so you can rely on accurate
measurements.

www.keysight.com/quality
Keysight Electronic Measurement Group
DEKRA Certified ISO 9001:2008
Quality Management System

Keysight Channel Partners
www.keysight.com/find/channelpartners
Get the best of both worlds: Keysight’s measurement expertise and product
breadth, combined with channel partner convenience.

Web Resources
Product page:
www.keysight.com/find/n6158a and
www.keysight.com/find/w6158a

X-Series signal analyzers:
www.keysight.com/find/X-Series

X-Series advanced measurement applications:
www.keysight.com/find/X-Series_Apps

Signal Studio software:
www.keysight.com/find/digitalvideo

Signal Studio software:
www.keysight.com/find/SignalStudio

Signal generators:
www.keysight.com/find/sg